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Introduction 

The Engineering Field Tools (EFT) Framework is an application platform that coordinates a variety of software 
tools that enable engineering practices. The primary management interface to these tools is the EFT Overview. The 
Overview gives a snapshot of all customers, projects, and managers or tools available for use within EFT. The 
Overview interface consists of a Tree Area which shows an expandable list of Customers and associated Projects, 
and a Contents Area which gives a summary of the selected item. The Overview operates primarily on local EFT 
Customers, working with any number of their projects and sets of data (managers). Additionally, if you have 
NRCS’s Customer Service Toolkit (Toolkit) installed, Overview can work with Toolkit Customers. These Toolkit 
Customers are treated separately and shown in their own tree in the Tree Area. You do not need to have Toolkit 
installed to work with EFT. EFT is not designed to be a full-featured Toolkit management interface, so the way you 
work with Toolkit Customers and move back and forth between a Toolkit Customer and a local EFT Customer is 
explained in the Customer Service Toolkit (CST) Interaction section. 

Interface Overview 

 

 

Tree Area 

The tree area provides an alphabetically sorted navigation hierarchy for customer-oriented projects similar to the 
Windows file explorer. Projects associated with a Customer are shown beneath the Customer. Managers or tools that 
represent engineering applications are underneath Projects. A Customer may have multiple Projects and a Project 
may contain multiple named engineering tools, designers, or managers. 
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Contents Area 

The contents area takes up the majority of the right-hand side of the Overview. Detailed information about the item 
selected in the tree area, whether it be a customer, project, manager or tool, is shown here. 

 

Status Bar 

The status bar is located at the bottom of EFT. It's designed to give an indication of where you are similar to the 
navigation hierarchy provided by the customer tree. Look here for any status messages. 
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Overview Functionality 

Trees 

The tree area is the main hierarchical organization of Customers, Projects, and tools or managers. The tree follows a 
classic branch-leaf A "+" symbol next to a Customer or Project name indicates that the Customer or Project contains 
more items. Selecting the "+" will expand the container and display the contents alphabetically underneath that 
Customer or Project. This is a parent-child relationship. Selecting a "-" next to a parent will collapse that item. 

Customer Rollup Areas 

There are two possible Customer tree areas, the default EFT Customers tree area and, if you have Customer Service 
Toolkit installed, the Toolkit Customers area. For clarity, you can select the arrow beside the tree heading and 
collapse the whole tree, freeing up screen real estate. 

Refresh 

Typically, the list of Customers displayed in the tree is kept in synch by EFT. From time-to-time, though, the 
Customer tree may need to be refreshed manually. To refresh the Customer tree manually, right-click on the 
Customer tree's heading and a context menu will appear. Select "Refresh" and the tree will be repopulated with the 
latest data. 
 

Customer Service Toolkit (CST) Interaction 

Customer Service Toolkit (CST, Toolkit) is the primary conservation planning tool used by NRCS, districts and 
technical service providers that allows access to a central repository (the National Conservation Planning Database, 
NCPDB). If Toolkit is installed on the client machine, EFT can take advantage of a restricted amount of information 
downloaded by Toolkit. The Toolkit directory structure has an area, the Engineering folder, where EFT related data 
is stored. EFT interacts with this directory only. For more information about, obtaining or using Customer Service 
Toolkit please see the national Toolkit Training and Support website 
[http://www.itc.nrcs.usda.gov/toolkit/training.htm] or access the Toolkit Online Help 
[http://cst.nrcs.usda.gov/Toolkit/Help/]. 

Working with Toolkit Customers 

Prior to working with EFT, Toolkit customer information (metadata) must be exported via Toolkit so that EFT can 
see the checked-out Toolkit Customers. Once the metadata has been exported, any checked-out Toolkit customers 
will be visible to EFT. In order to make sure that there's no data corruption, EFT requires that a Toolkit customer be 
copied into a local EFT workspace and operated on from there. There are two ways to get Toolkit customer data - 
visible in the Toolkit Cusomers tree - once exported from the Toolkit application, into the EFT working space - 
visible as the EFT Customers tree. 

• Drag and Drop - select a customer from one tree and drag it to another tree 

• Menus - right-click a Customer or Customer's Project and use the context menus 
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Working with Customer and Project Menus 

Right-clicking on a Customer in the Toolkit Customers tree shows a context menu with two options: 

 

• Add Customer to EFT will copy the Toolkit Customer to the EFT Customers tree. The Customer is now ready 
and available to be used within EFT by EFT's various engineering tools. 

• Update Customer from EFT will synch any changes or designs made underneath the corresponding Customer's 
entry in the EFT Customers tree with the Toolkit Customers tree. The Customer is now ready to be checked-in to 
the NCPDB via the Toolkit program. 

Drag and Drop Between Trees 

 
The two major operations, copying and updating, can also be performed via drag-and-drop. Selecting a Customer 
with the mouse and dragging it from one tree to another will either: 

• Toolkit Customers tree to EFT Customers tree: copy the Customer from the Toolkit Customers tree to the EFT 
Customers tree, placing the Customer in the EFT working area. The Customer is now ready and available to be 
used with EFT. 

• EFT Customers tree to the Toolkit Customers tree: update the corresponding Customer's entry in the Toolkit 
Customers tree. Only the select Customer's information will be updated. A Customer cannot be placed on top of 
another Customer. Projects from one Customer cannot be dragged onto or into another Customer or Customer's 
project. 
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Synchronizing with Toolkit 

Once done with any changes in EFT and properly synchronized in the EFT Toolkit Customers tree, the normal 
Toolkit check-in process can be followed to synch with the NCPDB. See Toolkit Online Help 
[http://cst.nrcs.usda.gov/Toolkit/Help/] > Manage Toolkit Data > Check In/Out Customer Data > Check In a 
Customer Folder 

Italicized Customer names - What it means 

You may see a Customer whose name is italicized in the Toolkit Customers tree - this indicates that the customer is 
out of synch with the external Toolkit program or has been deleted. You should verify that your Toolkit application 
has exported the Customer in question properly. 
 

Working with Customers 

Menus for Toolkit Customer Tree 

 
Right-clicking on a Customer in the Toolkit Customer tree yields a context-menu with two options, Add Customer 
to EFT and Update Customer from EFT. 

• Add Customer to EFT will copy the Toolkit customer into the EFT Customers tree. The Toolkit customer will 
now show up as an EFT Customer and is available for use with any of EFT's managers or tools. 

Note 

Behind the scenes, EFT copies the Toolkit "Engineering" directory contents into EFT's default 
customer working space so that EFT can operate on customer data without interfering with Toolkit's 
normal function. 

• Update Customer from EFT action will copy the corresponding EFT default space contents into the Toolkit 
customer's local repository. A dialog box asking for confirmation of this process will be presented prior to 
copying. 
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Menus for EFT Customer Tree 

 
Right-clicking on a Customer's name will display a context menu of actions for Customers. 

• New Customer menu action will display a form pertinent to creating a new Customer. The new customer form 
has areas for the name, address, city, state, zip code, phone number, e-mail address, section, township, range, as 
well as an area for a free-text description for that customer. 

 

• Edit Customer menu action will display a dialog similar to the the New Customer dialog to allow editing of the 
specific customer's information. 

• SaveAs Customer will create a copy of the customer with a new name. A dialog box asking for the new name 
will appear when this action is selected. 

• Delete Customer will delete the currently selected customer. A confirmation alert will appear prior to deletion. 

• Export Customer to Zipfile will compress the customer's directory into a zip file, useful for archiving, transfer, 
or exchange. A file location dialog box will appear to complete the export. 
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• Import Customer from Zipfile will take a compressed directory containing a customer and import the contents 
into the EFT Customers area. 

Finally, New Project will create a new folder for managers underneath the current customer. A form for the name 
and description of the project will be presented when this action is selected. 
 

Working with Projects 

Menus for EFT Projects 

 
Right-clicking on a Project will bring up a context menu of options specific to Projects. 

• New Project will allow the creation of a new Project for the current customer. 

 

• Edit Project brings up a dialog so that the name and the description of the Project can be edited. 

• SaveAs Project copies the current project to another name for the same Customer. 

• Delete Project will delete a project. Confirmation will appear prior to deletion. 

Below these four Project actions there are tool/manager specific creation menu items. In the first image above, the 
Survey Engineering Tool and Waterway Design Tool have been installed in EFT, so the New Survey Manager and 
New Waterway Manager actions appear. Selecting one of these will prompt for the name of the manager and open 
the requested tool, as shown on the next page. 
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Working with Tool Managers 

Menus for EFT Tool Managers 

 
Right-clicking on a tool or tool manager will display a context-menu with four actions: Open, Delete, Rename, and 
Copy. 

• Open will initiate the specific engineering tool. For more information on specific engineering tools, look to the 
tool manager's Help documentation. 

• Delete will delete the tool data for this Customer's project. A confirmation dialog will appear prior to deletion. 

• Rename will allow a change to the manager's name. 

• Copy will create a duplicate of the tool manager in the same Customer's Project. 
 

New tool wizards 

 
Another way to create and start a new Tool or Manager is via the File menu Wizard. Each Tool that is installed in 
EFT will have their own "New Tool" wizard. The Wizard will walk you through creating a new manager for that 
tool, assisting in associating the new tool with a Customer and a Project Highlighted in the image above is the File 
menu access to the Waterway Design Tool Manager. 
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Concepts & Definitions 

Customer The top most organizational unit, contains Projects and the output of Tools 

Customer Service Toolkit Also known as Toolkit or CST, Toolkit is a software application created by 
the USDA's NRCS ITC. See Toolkit Homepage for more detailed 
information. If Toolkit is installed on the client machine a second tree, the 
Toolkit Customers tree, will appear in the EFT Overview. 

Drag and Drop The process of moving a customer or associated projects between two trees. 

Engineering Field Tools An EBAAG software application framework designed to integrate multiple 
software applications that can be used stand-alone or in concert to assist field 
engineers. 

Overview The primary view for EFT that organizes Customers, Projects, and 
engineering Tools. The Overview is made up of a Customer Tree Area, a 
Contents Area and a Status Bar. 

Project An organizational unit under Customers, contains the output of Tools 

Manager application See Tool. 

Tool An engineering software application, such as the Survey Engineering Tool or 
the Waterway Design Tool. Also referred to as a Manager application. 

Tree A hierarchical representation of a set of Customers and associated Projects 
and Tools. The main tree is called EFT Customers. A second tree, named 
Toolkit Customers, will appear if Customer Service Toolkit is installed on the 
client machine. 

 


